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Chapter 1

Introduction to 
AutoCAD Map 3D 2013 

Learning Objectives
After completing this chapter, you will be able to:
• Understand various terms in this textbook
• Start AutoCAD Map 3D 2013
• Use workspaces
• Work with various components of AutoCAD Map 3D
• Use AutoCAD Map 3D Help
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Introduction 
AutoCAD Map 3D 2013 is a Geographic Information System (GIS) application developed by 
Autodesk. Along with the standard drafting tools, AutoCAD Map 3D is equipped with tools that 
are used to capture, edit, update, and analyze geospatial data. Moreover, the interoperability 
of AutoCAD Map 3D 2013 allows it to read, write, and convert data into data format used by 
other GIS applications. 

AutoCAD Map 3D supports various raster and vector data formats such as *.tif, *.dem, *.jpeg, 
*.dwg, *.shp, *.dgn, and *.tab. It also supports survey data in *.xyz, *.gps, and *.csv file formats. 
The features in AutoCAD Map 3D also enable you to connect to the spatial data using the 
relational database management system (RDBMS). By using these features, the productivity 
and management of spatial data will be enhanced. 

The various powerful tools and options available in AutoCAD Map 3D help you perform 
complex geospatial data analysis and obtain accurate results, thus making it an ideal tool for 
infrastructure planning, management, and decision making.

Geospatial analysis
Application of statistical analysis and other analytical techniques (such as network analysis, 
buffer analysis, and overlay analysis) to interpret the data related to a geographical area is known 
as Geospatial Analysis. In general, geospatial analysis is used to represent various methods of 
data interpretation such as analyzing, interpreting, and presenting the GIS dataset using GIS 
software. This type of data analysis is widely used in urban planning, landscape designing, 
geographical mapping, utility management, navigation, and disaster management. 

Various types of GIS data such as vector data, raster data, survey data, and point data are 
used in geospatial analyses. Different types of data are used for different types of geospatial 
analyses. Based on the project requirement, the type of GIS data to be used is selected. This 
may usually involve conversion of one type of data into another. Some of the commonly used 
GIS data are discussed next.

Vector or Feature Data
A vector or feature dataset is used to represent the spatial information of a geographical 
location. This type of dataset helps to retain the attributes in a table format attached with 
geometry, create and edit dataset, access an existing dataset for analysis, and perform spatial 
analysis. In general, there are three kinds of feature data used in geospatial analysis. They are 
point, line, and polygon. These feature data are discussed next. 

Point Feature
A point feature represents a spatial point for a specific object. A post box, street lamp, fire 
hydrant, and tree are some of the geographical objects that are represented as point objects. 
The point feature represents only one geographical location. 
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Line or Polyline Feature
A line or polyline feature is used to represent a linear feature or a streamlined feature data 
such as roads, transmission lines, streams, rivers, pipe networks, and boundaries.

Polygon Feature 
A polygon feature (parcel) is a closed polyline object with the attribute or property data attached 
to it. The polygon feature is used to represent an area feature such as council boundary, plots, 
farms, zones, wards, and water bodies such as lakes and ponds.

Raster Data
Raster data consists of a matrix of cells, also known as pixels, organized into rows and columns. 
Each cell in a raster contains a value that represents information, such as elevation and 
temperature. You can graphically display the data in the raster by using various rendering 
techniques. These techniques help you to render data in various color schemes. 

You can insert a raster file into the drawing and then use it to digitize vector data. 
In AutoCAD Map 3D 2013, you can also import point files and LiDAR data into the 
workspace and then generate 3D raster surfaces. You can also analyze and display the raster 
data using various tools.

Drawing Object Data
The attribute data and properties attached to a geometry is called drawing object data. These 
data can be in the form of point, line, polyline, or dotted lines with the attribute or property 
data attached to them. Some of the terms used in this book, related to drawing objects, are 
explained next.

Property
The property of a drawing object refers to the display parameters such as color of geometry, 
line thickness, and line pattern.

Attribute 
Attribute refers to the data that is attached to a drawing object and does not provide any 
information about the display parameters of the drawing object it is attached to. For example, 
the area and population of a state attached to a closed polyline object (polygon), records of 
births and deaths pertaining to a geographical place attached to a point object, number of 
accidents attached to a line or polyline object (roads, streets, highways, and motor ways). 

Data Table
Data table is the way of presentation of the property and attribute values in the form of a 
table. It is attached to an object, a layer, or a feature in a Workspace. Figure 1-1 shows various 
parts of a data table.

Data Field
In a data table, the data field displays a group of attribute values related to a specific data 
object. A data field is also referred to as an attribute or property.
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Figure 1-1  Various parts of a data table

Attribute Value
Attribute value of a drawing object is the value corresponding to this drawing object in various 
data fields. For example: attribute value of the Line object02 drawing object in the No. of 
vehicles/hr data field is 157, refer to Figure 1-1. 

Survey Data
Survey data is the point data obtained by locating specific survey points on the earth surface. 
The survey data can be obtained by using survey instruments such as total station, GPS, and 
so on. 

Industry Model Data
Industry Model Data is a new name given to the topobase database. Topobase is the database 
that includes features, parcels, and attribute data of a geographical location. Industry model 
data includes project settings, privileges, attribute data, and coordinate and projection systems 
related to a project. The projects such as infrastructure project management, utility designing, 
and facility management extensively use the industry model data for project management. 

Note
For creating the industry model you will require Autodesk Infrastructure Administrator 
application installed in your system. To install this application select the check box corresponding 
to Autodesk Infrastructure Administrator 2013 while installing the AutoCAD Map 3D 
2013 software.

Layers 
Layers are the overlays containing specific geometry, property, and attributes. You can transform 
data from one layer to another based on the file formats of data. In AutoCAD Map 3D, you 
can use layers in the form of the AutoCAD drawing layer and the vector or feature layer. These 
two layer types are discussed next.

AutoCAD Layer
AutoCAD layer is a drawing layer that contains drawing objects (text, point, line, and polygon) 
and their properties. You can create and modify a drawing layer within a drawing file and it 
cannot be used as an independent layer in other software. If you want to use AutoCAD layer 
in any other software, then you need to export or save the AutoCAD drawing layer in the file 
format recognized by the software requirement. 
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Vector or Feature Layer
Vector or feature layer is an independent layer that contains all feature data spatially related 
to a geographical location. Vector or feature layer can be in the SHP or SDF file format. It is 
easy to transfer feature data from one software to other using these types of layers. 

Starting autocad map 3d 2013
To start AutoCAD Map 3D 2013 from the Windows taskbar, choose the Start button at the 
bottom-left corner of the screen; a menu will be displayed. In this menu, choose Programs > 
Autodesk > AutoCAD Map 3D 2013 > AutoCAD Map 3D 2013, as shown in Figure 1-2; the 
AutoCAD Map 3D 2013 application will start and the Workspaces page will be displayed.

Figure 1-2  Starting AutoCAD Map 3D 2013 from the taskbar

Workspace 								     
Workspace is a combination of menus, toolbars, ribbon, palettes, and control panels. It is used 
to represent a customized drawing environment based on user requirements. You can also 
customize a workspace to suit the working environment of a task. 
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When you start AutoCAD Map 3D 2013 for the first time, the AutoCAD Map 3D - Select Your 
Default Workspace window will be displayed, as shown in Figure 1-3. In this window, you can 
read information about the three predefined workspaces that are available in AutoCAD Map 
3D. These workspaces are Planning and Analysis Workspace, Maintenance Workspace, and 
2D Drafting Workspace. 

Tip: You can choose a different workspace at anytime after starting AutoCAD Map 3D 2013  
application. To do so, select the required workspace options in the Workspace drop-down 
list in the Quick Access Toolbar.

To choose a workspace, select the radio button corresponding to the required workspace and 
then choose the Select button in the AutoCAD Map 3D - Select Your Default Workspace 
window; the window will be closed and the AutoCAD Map 3D 2013 screen will be displayed 
with the selected workspace. The three predefined workspaces in AutoCAD Map 3D software 
are discussed next. 

Figure 1-3  The AutoCAD Map 3D - Select Your Default Workspace window

Planning and Analysis Workspace
By default, the Planning and Analysis Workspace radio button is selected in the AutoCAD 
Map 3D - Select Your Default Workspace window. As a result, when you choose the Select 
button in the window, AutoCAD Map 3D interface opens in Planning and Analysis Workspace. 
In this workspace, the tools are grouped in different categories based on their uses in layout 
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planning and GIS analyses. Figure 1-4 shows the ribbon displayed in the Planning and 
Analysis Workspace. 

Figure 1-4  Partial view of the ribbon in the Planning and Analysis Workspace

Note
The theory and tutorial sections of all chapters in this textbook are discussed based on the 
Planning and Analysis Workspace ribbon interface. Hence, it is recommended to retain default 
settings, unless otherwise instructed, while using this textbook.

Maintenance Workspace
The Maintenance Workspace is a ribbon interface in which tools are grouped in different 
panels based on their usage in an industry model or project. The tools in this interface are 
very useful when you are working with an industry model data, an infrastructure project, or a 
utility project. Also, it helps to administer an entire project by specifying the required privileges 
to each member of the team. To invoke this workspace, select the Maintenance Workspace 
radio button in the AutoCAD Map 3D - Select Your Default Workspace window and then 
choose the Select button; the Maintenance Workspace will be displayed in the AutoCAD 
Map 3D interface. Figure 1-5 shows the ribbon in the Maintenance Workspace. You can use 
various tools in this workspace to maintain an industry model data. 
 

Figure 1-5  Partial view of the ribbon in the  Maintenance Workspace

2D Drafting Workspace
The 2D Drafting Workspace is a customized interface for drafters and designers. This 
workspace is very helpful for those who are familiar with AutoCAD ribbon and mostly work 
with the drawing data. In this workspace, the panels are customized based on the use of each 
tool in drafting. To invoke this workspace, select the 2D Drafting Workspace radio button in 
the AutoCAD Map 3D - Select Your Default Workspace window and then choose the Select 
button; the 2D Drafting Workspace will be displayed in the AutoCAD Map 3D 2013 interface. 
You can use various tools in this workspace to maintain an industry model data.

switching Workspaces 
After starting the AutoCAD Map 3D 2013 application, you can switch from one workspace to 
a different workspace. To switch from one workspace to another, select the required option 
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from the Workspace drop-down list located in the Quick Access toolbar, refer to Figure 1-6; 
the current workspace will be replaced by the selected workspace. 

Figure 1-6  Choosing the Maintenance Workspace option 
from the Workspace drop-down list 

Note
While reading this textbook, it is recommended not to invoke the Map Classic Workspace user 
interface, as the approach of accessing tools and the procedure of invoking various dialog boxes 
may differ from those explained in this textbook. 

AutoCAD Map 3d 2013 Interface
AutoCAD Map 3D 2013 interface consists of drawing area, ribbon, command line,  
Quick Access toolbar, Task Pane, model and layout tabs, and status bar, refer to Figure 1-7. 
The header section of the application interface displays the name of the current drawing file. 
The different components of the AutoCAD Map 3D 2013 interface are discussed next.

Figure 1-7  AutoCAD Map3D 2013 interface
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Application Menu
The Application button is located at the top-left of the AutoCAD Map 3D 2013 screen. Choose 
the Application button; the Application Menu will be displayed, as shown in Figure 1-8. The 
menu contains some of the tools that are available in the Standard toolbar. Alternatively, press 
ALT+F to display the tools in the Application Menu. You can search a command using the 
search field on the top of the Application Menu. To search a command, enter the complete 
or partial name of the command in the search field; a list showing all possible commands will 
be displayed. You can click on the desired command from the list to activate it. 

Figure 1-8  The Application Menu

By default, the Recent Documents button is chosen in the Application Menu. As a result, the 
recently opened drawings will be listed on the right in the Application Menu. Click on the 
required file name in the list to open the file. To open a file that is not listed in this menu, 
choose the Open button in the Application Menu; the Select File dialog box will be displayed. 
Browse to the location of the required file. Click on the file name and then choose the Open 
button; the selected file will be opened in the drawing area. In AutoCAD Map 3D 2013, you 
can specify the settings of the Display, User Preferences, Files, and Drafting parameters in 



1-10 		  Exploring AutoCAD Map 3D
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

the Options dialog box. To invoke this dialog box, choose the Options button displayed at 
the bottom-right of the Application Menu. Next, use the options in this dialog box to specify 
the required parameters.

To exit AutoCAD Map 3D, choose the Exit AutoCAD Map 3D 2013 button in the Application 
Menu.

Ribbon
In AutoCAD Map 3D, the tools for creating, modifying, and annotating are available in different 
panels of the ribbon instead of being spread out in the entire drawing area in different toolbars 
and menus, refer to Figure 1-4.

When you start the AutoCAD session for the first time, by default the ribbon is displayed 
horizontally below the Quick Access toolbar. The ribbon consists of various tabs. These tabs 
have different panels, which in turn have tools arranged in rows. Some of the tools have 
a small black down arrow. This arrow indicates that the tools having similar functions are 
grouped together. To choose a tool, click on the down arrow next to them; a drop-down will 
be displayed. Choose the required tool from the drop-down displayed. Note that if you choose 
a tool from the drop-down, the corresponding command will be invoked and the tool that you 
have chosen will be displayed in the panel. For example, to draw a circle using the 2-Point 
option, click on the down arrow next to the Center, Radius tool in the Draw panel of the 
Home tab; a drop-down will be displayed. Choose the 2-Point tool from the drop-down and 
then draw the circle. You will notice that the 2-Point tool is displayed in place of the Center, 
Radius tool. In this textbook, the tool selection sequence will be written as choose the 2-Point 
tool from Home > Draw > Circle drop-down.

To expand a panel, you can choose the down arrow next to it. The panel will be expanded 
and you will notice that a push-pin is available at its left end. Click on the push-pin to keep 
the panel in the expanded state. Also, some of the panels have an inclined arrow at the  
lower-right corner. When you click on the inclined arrow, a dialog box is displayed. You 
can define the settings of the corresponding panel in this dialog box.

You can reorder the panels in the tab. To do so, press and hold the left mouse button on the 
panel to be moved and drag it to the required position. To undock the ribbon, right-click on 
the blank space in the ribbon and choose the Undock option. You can move, resize, anchor, 
and auto-hide the ribbon using the shortcut menu that will be displayed when you right-click 
on the heading strip. To anchor the floating ribbon to the left or right of the drawing area in 
the vertical position, right-click on the heading strip of the floating ribbon; a shortcut menu 
is displayed. Choose the required option from this shortcut menu. The Auto-hide option will 
hide the ribbon into the heading strip and will display it only when you move the cursor over 
this strip.

You can also customize the display of tabs and panels in the ribbon. To customize the ribbon, 
right-click on any one of the tools in it; a shortcut menu will be displayed. On moving the cursor 
over one of the options, a flyout will be displayed with a tick mark before all options. Also, 
the corresponding tab or panel will be displayed in the ribbon. Select/clear the appropriate 
option to display/hide a particular tab or panel.
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Drawing Area
The drawing area covers the major portion of the screen. In this area, you can draw objects 
by using various tools/commands. To draw an object, you need to define coordinate points. 
You can do so by using the pointing device. The cursor represents the position of the pointing 
device on the screen. There is a coordinate system icon at the lower-left corner of the drawing 
area. 

Drawing Status Bar
The Drawing Status Bar is displayed between the drawing area and the command window. 
To display the Drawing Status Bar, if it is not displayed, choose the Application Status Bar 
Menu button displayed on the Status Bar, refer to Figure 1-13, and choose the Drawing 
Status Bar option from the flyout displayed; the Drawing Status Bar will be displayed, as 
shown in Figure 1-9. The Drawing Status Bar displays the Coordinate System, Vertical 
Exaggeration, Isolate Object, and View Scale buttons. Various options in the Drawing Status 
Bar are discussed next.

Figure 1-9  The options in the Drawing Status Bar

2D Button
The 2D button is used to switch from 3D to 2D working environment. When you 
apply the map2d.dwt template settings to the current drawing, you will enter the 2D 

drafting and designing environment and the 2D button will be activated. The map2d.dwt is a 
template file that contains the settings of the 2D drawing environment.  

3D Button
The 3D button is used to switch from 2D to 3D working environment. When you 
apply the settings from the map3d.dwt template file, you will enter the 3D designing 

environment and the 3D button will be activated.

Vertical Exaggeration
The Vertical Exaggeration option is used to change the vertical scale of the drawing. The 
vertical exaggeration is used to raise or lower the vertical features which might appear too 
small or big relative to the horizontal scale in the drawing. To specify the exaggeration factor 
for visual enhancement, left-click on the down-arrow next to the Vertical Exaggeration button 
in the Drawing Status Bar; a flyout will be displayed. In this flyout, choose an option; the 
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display of the raster image will be enhanced based on the factor selected. Figure 1-10 shows 
the view of a raster image at the default vertical exaggeration (1x). Figure 1-11 shows an 
enhanced view of the raster image at vertical exaggeration of 2x.

Figure 1-10  Model vertically exaggerated to 1x Figure 1-11  Model vertically exaggerated to 2x

You can also specify a value of your choice for vertical exaggeration.

Figure 1-12  Choosing 
the Custom option for 
vertical exaggeration

 
To do so, left-click on the down-arrow corresponding to the Vertical 
Exaggeration option; a flyout will be displayed. In this flyout, choose 
the Custom option, as shown in Figure 1-12; a window will be 
displayed. In this window, enter the desired value in the Enter 
Exaggeration Value edit box and then choose the OK button; the 
window will be closed and the raster image will be vertically 
exaggerated to the specified value. 

Command Button
The Command button is used to display or hide the 
Command Line. By default, the Command Line is 

displayed. To hide the Command Line, choose the Command button; 
the Command Line-Close Window message window will be 
displayed. In this window, choose the Yes button; the Command 
Line will be removed from the screen. Choose the Command button again to display the 
Command Line. Alternatively, you can press CTRL + 9 to show or hide the Command 
Line.

Warning Button
The Warning button is used to display the details of errors that have occurred while 
performing an action. By default, this button is inactive. When an error occurs, this 

button becomes active (it will be highlighted in yellow color). To view the description of the 
error occurred, click on the Warning button; the AutoCAD Map Messages dialog box will be 
displayed. This dialog box has two areas: Messages and Message details. Next, select a message 
in the Messages area; the details pertaining to the selected message will be displayed in the 
Message details area. You can use the Show Log File button to view additional information 
about the selected option. On choosing this button, the log file of the error will be displayed 
in a notepad. 

Isolate Objects
This button is used to hide or isolate objects from the drawing area. On choosing this 
button, a flyout will be displayed with two options: Isolate Objects and Hide Objects. 
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Choose an option from this flyout and then select the objects to hide or isolate. To end isolation 
or display a hidden object, choose this button again and choose the End Object Isolation 
option.

Click to link/unlink AutoCAD Map 3D stylization while zooming
After a style has been applied to a vector data, you can use this button to link or unlink 
the AutoCAD Map 3D stylization while zooming. If the lock in this button is closed, the 

style applied to the vector layer will be displayed at different zooming scales (stylization linked). 
If the lock in this button is open, the style applied to a vector layer will not be displayed 
(stylization is not linked). 

Drawing Status Bar Menu
The Drawing Status Bar Menu, refer to Figure 1-9, contains a list of options that can be added 
to the Drawing Status Bar. To add an option from this menu to the Drawing Status Bar, click 
on the Drawing Status Bar Menu button; a menu is displayed. Select the required option 
from the displayed menu; the selected option will be added to the Drawing Status Bar. The 
options in the Drawing Status Bar Menu are discussed next.

Annotation Scale
The Annotation Scale option has a drop-down list that displays all annotation 
scales available for the current drawing. The annotation scale is used to control 

the size and display of the annotative objects in the model space.
 

Annotation Visibility
This option is used to control the visibility of annotative objects that do not support 
the current annotation scale in the drawing area.

Automatically Add Scale
If this option is chosen, then the annotated objects in the drawing are scaled 
automatically based on the scale selected in the Annotation Scale drop-down list.

Command Line
The Command Line is located at the bottom of the drawing area, where you can enter 
commands to execute an action. It also displays the subsequent prompt sequences and messages. 
You can change the size of the Command Line. To do so, place the cursor on the top edge of 
the command line; the cursor will change into a double line bar known as the grab bar. Click 
and drag the command line to change the size. This way you can increase its size to see all the 
previously used commands. By default, the command window displays only three lines. You 
can also press the F2 key to display the AutoCAD Text window, which displays the previous 
commands and messages. 

Status Bar
The Status Bar, which is also called as the Application Status Bar, is displayed at the bottom 
of the screen. It contains tools and buttons that are used to perform various AutoCAD Map 
3D functions, refer to Figure 1-13. You can toggle most of the options on or off by choosing 
them. These options are discussed next.
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 Figure 1-13  The options in the Status Bar

Drawing Coordinates
The information about the coordinates is displayed on the left side of the Status Bar. You can 
set the display of coordinates in the Status Bar to static or dynamic. To change the coordinate 
display settings in the Status Bar, enter COORDS in the command line; you will be prompted 
to specify the new value. Specify the COORDS value in the command line. If the value is set 
to 0, the coordinate display will be static, which means that the coordinate values displayed in 
the Status Bar will change only when a point is specified. Setting the value of the COORDS 
variable to 1, 2, or 3 will display the coordinate in dynamic mode. If the variable is set to 1, 
AutoCAD Map 3D constantly displays the absolute coordinates of the graphics cursor with 
respect to the UCS origin.
 

Note
When you assign a global coordinate system to the Workspace, the coordinates of a spatial point 
with reference to the assigned coordinate system will be displayed in the Drawing Coordinates 
area.

Infer Constraints
You can choose the Infer Constraints button to automatically apply the geometric 
constraints while you create or edit a geometric object. 

Snap Mode
The Snap Mode button is chosen to activate the grid snap mode. If this mode is activated, 
the cursor will move in fixed increments using the current settings of the snap grid. The 

F9 key acts as a toggle key to turn the snap mode off or on. To change the snap spacing, 
right-click on the Snap Mode button; a shortcut menu will be displayed. Choose the Settings 
option from the menu; the Drafting Settings dialog box will be displayed with the Snap and 
Grid tab chosen by default. In the Snap spacing area of this tab, specify the required snap 
spacing along the X and Y axes in the corresponding edit boxes. Next, choose the OK button 
to apply the settings.

Grid Display
The grid lines are used as reference lines to draw objects in AutoCAD Map 3D. Choose 
the Grid Display button to toggle the display of the grid in the drawing area. Alternatively, 
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you can use the F7 key to toggle the grid display. To change the spacing of the grid lines, 
right-click on the Snap Mode button; a shortcut menu will be displayed. Choose the Settings 
option from the menu; the Drafting Settings dialog box will be displayed with the Snap and 
Grid tab chosen. In the Grid spacing area of this tab, specify the required spacing along the 
X and Y axes in the corresponding edit boxes. Next, choose the OK button to apply the 
settings.

Ortho Mode
This button is used to activate or deactivate the ortho mode. When this mode is active, 
you can draw lines at right angles only. Alternatively, choose the F8 key to turn this mode 

on or off.

Polar Tracking
If you turn the polar tracking on, the movement of the cursor is restricted along a path 
determined by the angle set as the polar angle. Choose the Polar Tracking button to 

turn the polar tracking on or off. You can also use the F10 key to turn this option on or off. 
Note that turning the polar tracking on, automatically turns off the ortho mode. 

Object Snap
You can use the Object Snap button to turn the object snap mode on or off. Alternatively, 
you can use the F3 key to turn the object snap mode on or off. Note that the status of 

OSNAP (off or on) does not prevent you from using the immediate mode object snaps.

3D Object Snap
When this button is chosen, you can snap the key point on a solid or a surface. You can 
also use the F4 key to turn the 3D object snap on or off.

Object Snap Tracking
When you choose this button, the inferencing lines will be displayed. Inferencing lines 
are dashed lines that are displayed automatically when you select a sketching tool and 

track a particular key point on the screen. Choosing this button turns the object snap tracking 
on or off.

Allow/Disallow Dynamic UCS
On choosing this button, you are allowed or disallowed the use of dynamic UCS. Allowing 
the dynamic UCS ensures that the XY plane of the UCS is dynamically aligned with the 

selected face of the model. You can also use the F6 key to turn the DUCS button on or off.

Dynamic Input
The Dynamic Input button is used to turn the Dynamic Input on or off. Turning it on 
facilitates the heads-up design approach because all commands, prompts, and 

dimensional inputs will now be displayed in the drawing area and you do not need to look at 
the Command prompt all the time. This saves the design time and also increases the efficiency 
of the user. If the Dynamic Input mode is turned on, you will be allowed to enter the commands 
through the Pointer Input boxes and the numerical values through the Dimensional Input 
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boxes. You will also be allowed to select the command options through the Dynamic Prompt 
options in the graphics window. To turn the Dynamic Input on or off, use the CTRL+D 
keys. 

Show/Hide Lineweight
Choose this button to turn on or off the display of lineweights in the drawing. If this 
button is not chosen, the display of lineweight will be turned off.

Show/Hide Transparency
This button is used to turn on or off the transparency set for a drawing. You can set the 
transparency in the Properties panel or in the layer in which the sketch is drawn.

Quick Properties
If you select a sketched entity when this button is chosen in the Status Bar, the properties 
of the selected entity will be displayed in a panel.

Selection Cycling
You can use this button to select an object from a group of two or more overlapping or 
closely placed entities. To select an object from the overlapping entities, choose the 

Selection Cycling button in the Status Bar; the selection cycling mode will be activated. Next, 
click at the required location to select an object; a list box will be displayed. This list box 
contains a list of objects at the selected location. Choose the required object from the list to 
proceed.

Model
You can choose the Model button in the Status Bar to invoke the model space environment 
in the drawing window. In the model space environment, you can create, edit, and update 

the drawing objects in the drawing model. 

Layout
You can choose the Layout button to switch into the layout space environment. In this 
environment, you can create a new or modify an existing layout. You can use these layouts 

for creating and publishing maps. 

Model or Paper source
The Model or Paper source button is used to switch between the model space and 
paper space while in the layout space environment. Switching to model space while 

in the layout environment will enable you to work on the drawing objects in the model. To 
switch to model space in the layout environment, choose the Model or Paper source button; 
the drawing objects in the model will become editable and the text on the button will change 
from PAPER to MODEL.  To switch back to paper space, choose the Model or Paper source 
button; the paper space will be invoked and now you can work with the map elements in the 
layout.
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Quick View Layouts
On choosing this button, thumbnails of the layouts in the current drawing are displayed. 
To choose a layout, click on the required layout thumbnail. 

Quick View Drawings
On choosing this button, thumbnails of the active drawings are displayed. When you 
place the cursor over the thumbnails, they are enlarged and you can choose the drawing 

that you need to invoke. 

Toolbar/Window Positions Unlocked
The Toolbar/Window Positions Unlocked button is used to lock and unlock the positions 
of toolbars and windows. When you choose this button, a shortcut menu is displayed. 

Choosing the Floating Toolbars/Panels option allows you to lock the current position of the 
floating toolbars. Also, a check mark is displayed against those toolbars in the shortcut menu 
that are currently locked. Choosing the Docked Toolbars/Panels option from the shortcut 
menu allows you to lock the current position of all the docked toolbars. Similarly, you can lock 
or unlock the position of floating and docked windows such as the Properties window or the 
Tool Palettes. If you move the cursor on the All option,

Figure 1-14  The Task Pane

 
a cascading menu is displayed that provides the option 
to lock and unlock all the toolbars and windows.

Note
The LOCKUI system variable is used for the locking and 
unlocking of the toolbars and windows. The following 
are the values of the system variable:

Lockui<0> No toolbar or window locked 
Lockui<1> Locks all docked toolbars
Lockui<2> Locks all docked windows
Lockui<4> Locks all floating toolbars
Lockui<8> Locks all floating windows

Hardware Acceleration On
This button is used to set the performance of the 
software at an acceptable level.

Task Pane
The Task Pane is displayed on the right of the AutoCAD 
Map 3D 2013 screen, as shown in Figure 1-14. To hide/
show the Task Pane in the interface, choose the Map Task 
Pane button in the Palettes panel of the View tab.

You will find alternative options to the ribbon interface 
in the Task Pane. In the Task Pane, there are four tabs: 
Display Manager, Map Explorer, Map Book, and Survey. 
These tabs are explained next.
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Display Manager Tab
The options in the Display Manager tab are used to connect and display feature layers and 
then perform various types of analyses on these feature layers.
  
Map Explorer Tab
The options in the Map Explorer tab are used to assign the rights of a drawing to a user, 
attach new drawings to the current drawing, define queries, and so on. 

Map Book Tab
The options in the Map Book tab are used to divide a large map into small tiles. You can then 
render each tile on a separate page. You can publish map book online or can have paper 
print. 

Survey Tab
The options in the Survey tab are used to import and export the survey data, and create a 
data store.

Navigation Bar
In AutoCAD Map 3D 2013, the commonly used tools for

Figure 1-15  The tools in the 
Navigation Bar

 
navigation are grouped together in a tool bar known as the 
Navigation Bar. By default, this toolbar is placed on the 
r ight  hand top corner  in  the  drawing area . 
Figure 1-15 shows the Navigation Bar available in the 
AutoCAD Map 3D 2013. The tools in the Navigation Bar 
are discussed next. 

ViewCube
The ViewCube tool is used to switch between the standard 
and isometric views or to roll the current view. 

Navigation Wheel
The Navigation Wheel has a set of navigation tools such 
as pan, zoom, and orbit. You can use any of these options 
to set the view of a drawing in the drawing window. 

Pan
This tool allows you to view the portion of the drawing that is outside the current display area. 
To view the outside portion, choose this tool, press and hold the left mouse button, and then 
drag the drawing area. Press ESC to exit this tool.

Zoom
A list of various zoom tools are displayed in the Zoom drop-down. The options in the Zoom 
drop-down are used to enlarge or reduce a view in the drawing window without affecting the 
actual shape and size of the objects in this view. 
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Orbit
The tools in the Orbit drop-down are used to rotate a view in the drawing window in the 3D 
space.

ShowMotion
Choose this button to capture different views in a sequence and animate them when 
required.

AutoCAD Map 3d dialog boxes
There are certain commands, which when invoked, display a dialog box. A dialog box is a 
secondary window that allows the users to specify attributes and parameters to perform various 
tasks. It is also used to provide the users with information or progress feedback. A typical dialog 
box has a name, radio buttons, text or edit boxes, check boxes, slider bars, image boxes, and 
command buttons. Figure 1-16 shows some of the components in a dialog box.

   Figure 1-16  Components of a dialog box

The Title Bar displays the name of a dialog box. Tabs contain various sections with a group 
of related options under them. The check boxes are toggle buttons for making a particular 
option available or unavailable. The drop-down list displays a list of items to choose from; only 
one item can be selected at a time. The text box is an area where you can enter any text like 
a file name. It is also called an edit box because you can make changes to the text entered in 
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it. In some dialog boxes, there is the [...] button, which when chosen displays another related 
dialog box. There are certain command buttons (OK, Cancel, and Help) at the bottom of the 
dialog box. The names of these buttons imply their functions. The button with a dark border 
is the default selected button. A dialog box may also have a Help button which when clicked 
will show related help on various features of the dialog box.

AutoCAD Map 3D HELP
You can get online and offline help regarding the use and working of AutoCAD Map 3D 2013 
commands by using various options such as command line, help menu or, the F1 key on the 
keyboard. 

You can also access the help topic by using the search option in the InfoCenter bar. The 
InfoCenter bar also provides links to other online resources which are useful in exploring 
AutoCAD Map 3D. Some of the options in the InfoCenter bar are discussed next.

InfoCenter Bar
By default, the InfoCenter bar is located on the

Figure 1-17  The InfoCenter bar

 
right side in the AutoCAD Map 3D application 
title bar. Various options to search for help and 
web links for direct access to online information 
resources are given in the InfoCenter bar. 
Figure 1-17 shows various tools and options in 
the  InfoCenter bar. Some of the options in this 
bar are discussed next. 

InfoCenter Text Box and Search 
Button
To access help, click in the text box of the InfoCenter bar and enter the keywords or questions 
to be searched for and then choose the Search button; the AutoCAD Map 3D Help window 
will be displayed, refer to the Figure 1-18. 

Note
You can directly invoke the AutoCAD Map 3D Help window by pressing the F1 key.

Autodesk Exchange Apps
On choosing the Autodesk Exchange Apps button from the InfoCenter bar, the Autodesk 
Exchange Apps website will be opened. This website is an online resource from where you can 
browse and download e-books, models, training materials, and add-ons for your AutoCAD 
product. Some of the products available are free to download. 

Stay Connected 
You can use the options in the Stay Connected drop-down list to verify whether the AutoCAD 
product is up-to-date and also connect to the Autodesk Subscription Center which is the 
online community for AutoCAD.



Introduction to AutoCAD Map 3D 2013					          1-21
E
va

lua
tion C

opy. D
o not reproduce. For inform

a
tion visit w

w
w

.ca
dcim

.com

Figure 1-18  The AutoCAD Map 3D Help window

Help
The Help drop-down list contains options that provide links to various useful resources. 
Figure 1-19 shows options in the Help drop-down list of the InfoCenter bar. These options 
are discussed next.

 Figure 1-19  The options in the Help drop-down list

Help 
On choosing the Help option from the drop-down list, the AutoCAD Map 3D Help 
window will be displayed, as shown in Figure 1-18. You can use this window to access help 
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on different topics and commands. Using the instructions in this window, you can easily 
understand various tools and methods used in AutoCAD Map 3D 2013. Additionally, you 
can access online help documentation as well as local (offline) help documentation. 

In this window, you can access the help files related to certain keywords. To do so, choose 
the Search tab in the left pane. Next, enter any keyword in the Search edit box located 
in the left pane; topics containing the searched keyword will be displayed in a list below 
the Search edit box. Choose the required topic from the search result; the right pane 
will display the content within the selected topic. You can also search the help topics by 
the relevance of the contents. To do so, choose the Contents tab; the AutoCAD Map 3D 
contents are logically grouped and displayed in a hierarchical order in the left pane. Some 
heads in the hierarchy may contain subhead. To view the contents within these subheads, 
expand the nodes corresponding to the subhead by choosing the + symbol displayed to 
the corresponding node. To view the content of the topic, choose the topic name; the 
right pane will display the content of the selected topic. 

 
Learning Resources
AutoCAD Map 3D provides some basic learning resources to the user. To view these 
resources, select the Learning Resources option from the Help drop-down list; the 
AutoCAD Map 3D help window will be displayed with links to the learning resources. 
In this window, you can click on the desired link to display information for the required 
topic.

Additional Resources
The links in this option can be used to access the Autodesk User Group International 
and AutoCAD Map 3D websites. These websites can be used as additional resources and 
forums to discover information about AutoCAD Map 3D. 

Developer Resources
The Developer Resources option contains link to connect to the Autodesk Developer 
Network web page. This web page provides access to the blog and forums that can be useful 
for software developers working with Autodesk Infrastructure Modeling technologies.

Customer Involvement Program
This option is used to share information about your system configuration and usage 
of products with Autodesk. The collected information is used by Autodesk for the 
improvement of Autodesk software.

Product Wishes
This option is used to display the discussion forum of the Authorized Developer Network 
group. 

About AutoCAD Map 3D
This option gives you information about the release, serial number, licensed to, and the 
legal description about AutoCAD Map 3D 2013.
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More Help
1.	 Almost all dialog boxes in AutoCAD Map 3D have a Help button. You can access help 

on various topics by choosing this button. In case, the Help button is not displayed in a 
dialog box, press the F1 key on the keyboard; the help window for the dialog box will be 
displayed.

2.	 Some of the dialog boxes have a question mark (?) button at the top right corner just 
adjacent to the close button. When you choose this button, the ‘?’ symbol gets attached 
to the cursor. You can then drop this symbol on any item in the dialog box to display 
information about that particular item.

3.	 Help regarding various tools and buttons is also displayed in form of tool tips. Hover the 
pointer over a tool or button; a short description related to the chosen button or tool will 
be displayed in a tooltip. To activate or deactivate a tooltip, invoke the Options dialog box 
by entering the OP command in the command line. Next, choose the Display tab in the 
Options dialog box. Next, in the Window Elements area of the Display tab, select or clear 
the Show ToolTips check box to activate or deactivate the tool tip, refer Figure 1-20.

Figure 1-20  Selecting the Show ToolTips check box from the Options dialog box
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Abbreviations of the File Formats 
In this textbook, some of the vector layers have been specified by their respective file formats. 
The description of abbreviation of the file formats used in this text book is given below.

Abbreviation  Description

 DWG  Drawing file (AutoCAD file format)

 DWT  Drawing template file (AutoCAD file format)

 DWF  Drawing Web Format (AutoCAD file format)

 SHP  Shape file ( ESRI file format)

 SDF  Spatial Data File ( Autodesk file format)

 CSV  Comma Separated Variables ( MS Excel file format)

 TXT  Text file

 JPEG  Joint Photographic Experts Group (Image file) 

 TiFF  Tagged Image Format File (Image file)

 ISD  Index file generated for point cloud data

 LAS and
 LSD

 LiDAR data file format

 GPS  Global Positioning System


